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ELECTRICAL AND ELECTRONICS  ENGINEERING 
 

Program Outcomes 

PO1 
Engineering Knowledge: Apply the knowledge of mathematics, science, engineering fundamentals, and 

an engineering specialization to the solution of complex engineering problems. 

PO2 

Problem Analysis: Identify, formulate, review research literature, and analyze complex engineering 

problems reaching substantiated conclusions using first principles of mathematics, natural sciences, and 

engineering sciences. 

PO3 

Design / Development of Solutions: Design solutions for complex engineering problems and design 

system components or processes that meet the specified needs with appropriate consideration for the 

public health and safety, and the cultural, societal, and environmental considerations.  

PO4 

Conduct Investigations of Complex Problems: Use research-based knowledge and research methods 

including design of experiments, analysis and interpretation of data, and synthesis of the information to 

provide valid conclusions.  

PO5 

Modern Tool Usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities with an 

understanding of the limitations.  

PO6 

The Engineer and Society: Apply reasoning informed by the contextual knowledge to assess societal, 

health, safety, legal and cultural issues and the consequent responsibilities relevant to the professional 

engineering practice.  

PO7 

Environment and Sustainability: Understand the impact of the professional engineering solutions in 

societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development.  

PO8 
Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of the 

engineering practice. 

PO9 
Individual and Team Work: Function effectively as an individual, and as a member or leader in diverse 

teams, and in multidisciplinary settings.  

PO10 

Communication: Communicate effectively on complex engineering activities with the engineering 

community and with society at large, such as, being able to comprehend and write effective reports and 

design documentation, make effective presentations, and give and receive clear instructions.  

PO11 

Project Management and Finance: Demonstrate knowledge and understanding of the engineering and 

management principles and apply these to one’s own work, as a member and leader in a team, to manage 

projects and in multidisciplinary environments.  

PO12 
Life - Long Learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life - long learning in the broadest context of technological change.  
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Program Specific Outcomes 

PSO1 
Professional Skills: Able to utilize the knowledge of high voltage engineering in collaboration with 

power systems in innovative, dynamic and challenging environment, for the research based team work. 

PSO2 

Problem - Solving Skills: Can explore the scientific theories, ideas, methodologies and the new cutting 

edge technologies in renewable energy engineering, and use this erudition in their professional 

development and gain sufficient competence to solve the current and future energy problems universally. 

PSO3 

Successful Career and Entrepreneurship: The understanding of technologies like PLC, PMC, process 

controllers, transducers and  HMI one can  analyze, design  electrical and electronics principles to install, 

test , maintain power system and applications. 
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ATTAINMENT OF PROGRAM OUTCOMES & PROGRAM SPECIFIC OUTCOMES 

 

S. No List of Experiments 

Program 

Outcomes 

Attained 

Program 

Specific 

Outcomes 

Attained 

1 Sensing of temperature and speed PO1, P09 PSO2, PSO3 

2 Calculation of distance and level PO1, PO9 PSO2, PSO3 

3 Measurement of strain and pressure PO1, PO2 PSO2, PSO3 

4 Measurement of position and linear displacement PO2, PO9 PSO2, PSO3 

5 Phantom loading on LPF wattmeter PO1, PO9 PSO2, PSO3 

6 Calibration of single phase energy meter and power factor meter PO1, PO9 PSO2, PSO3 

7 Measurement of turns ratio and application of CTS PO1, P09 PSO2, PSO3 

8 Measurement of reactive power PO1, PO2 PSO2, PSO3 

9 Net metering PO1, PO9 PSO2, PSO3 

10 Measurement of frequency and THD using digital simulation PO1, PO9 PSO2, PSO3 

11 Analysis of alternating quantities using digital simulation PO1, PO12 PSO2, PSO3 

12 Two wattmeter method using digital simulation PO1, PO2 PSO2, PSO3 

13 Working of static energy meter using digital simulation PO1, PO9 PSO2, PSO3 

14 
Measurement of passive parameters using ac and dc bridges 

using digital simulation 
PO1, PO2 PSO2, PSO3 
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ELECTRICAL MEASUREMENTS LABORATORY 

 

 

 

OBJECTIVE: 

 
The objective of this lab is to teach students to know the procedures for measuring Resistance, Inductance and 

Capacitance of different ranges. To perform experiments to measure three phase power, frequency, core losses. 

To design experiments for calibration of energy meter and to know the industrial practices of Measuring earth 

resistance, dielectric strength of transformer oil & Testing of underground cables. 

 

OUTCOMES: 

 
1. Upon completion of study of the course should be able to calibrate and test single phase energy 

meter, calibrate PMMC voltmeter and calibrate LPF wattmeter. 

2. Student should be able to measure resistance, inductance and capacitance. 

3. Students should be able to measure 3-Φ active power and reactive power. 

4. Students should be able to test current transformers and dielectric strength of oil.  

Students should be able to calibrate LVDT and resistance strain gauge. 
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EXPERIMENT - 1 

 (A) SENSING OF TEMPERATURE AND SPEED 

1.1 AIM:  

Measurement of temperature using transducers like thermocouple, thermistors and resistance                      

temperature detector with signal conditioning; Speed measurement using proximity sensor 
 

1.2 APPARATUS: 

Temperature transducers, digital temperature indicator, Thermometer, Electric sterilizer. 

1.3     CIRCUIT DIAGRAM: 

 

            Voltmeter

Measuring Junction(Hot)
Reference Junction 

(Cold)

Dissimilar metal Wires

Heat Source

 
 

Fig – 1.1 Thermocouple 
 

Type of the sensor: “J” type 

Material use: chromium Alumel 
 

RTD: 
 

RED

WHITE
RTD 

Element  
 

Fig – 1.2 RTD 
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Specification – RTD 

Type: PT 100 
Resistance value: 100 Ω at 00 C 

 

THERMISTER: 
 

             To VPS(+)

To Ground

     10 KΩ

             Thermistor

          To DMM

     To Ground

 

Fig – 1.3 Thermister 

Temperature measuring circuit using thermister 

 

1.4  PROCEDURE: 

1. Select the Thermocouple/RTD/Thermister by selector switch. 

2. Connect the Thermocouple/RTD/Thermister to sensor socket provided at front panel. 

3. Set the min pot to read the ambient temperature in display. 

4. Insert Thermocouple/RTD/Thermister in the hot bath. 

5. Digital LED display shows the temperature obtaining at the hot bath directly in degrees Celsius. 

6. If necessary adjust the max pot for the maximum level of temperature calibration. 

7. Recorder red and green terminals for the anal output. 

8. Fuse holder provider to protect the circuit from the over load (500 mA). 
 

1.5 TABULAR COLUMN: 

S. No 
Thermocouple Reading in oC RTD 

Reading 

In oC 

Thermister 

Reading 

In oC 

Thermometer 

Reading 

In oC J K T 
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Graphs: 

 

1. Thermometer Reading Vs Thermister Reading 
2. Thermometer Reading Vs RTD Reading 

3. Thermometer Reading Vs J-type Thermocouple Reading 
4. Thermometer Reading Vs K-type Thermocouple Reading 

5. Thermometer Reading Vs T-type Thermocouple Reading 

 

 
 

Fig – 1.4 Model Graph 

 
 

1.6 RESULT: 

 
 

 

 

 

 

 

 

1.7 PRE LAB VIVA QUESTIONS: 
 

 

1. What is the working principle of thermocouple? 

2. What are the types of thermocouple? 

3. What is the cold junction compensation techniques? 

4. What are the advantages of thermistors? 

 

1.8 POST LAB VIVA QUESTIONS: 
 

1. What are the limitations of thermistors? 

2. What are the various configurations of thermistors? 

3. What do you mean by RTD? 

4. Which material is generally used in the construction of RTD? 
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EXPERIMENT - 1 

 (B) SENSING OF TEMPERATURE AND SPEED 

1.1 AIM:  

Measurement of temperature using transducers like thermocouple, thermistors and resistance                      

temperature detector with signal conditioning; Speed measurement using proximity sensor. 
 

1.2 APPARATUS:  

Digital speed indicator, optical or photo sensor, Proximity or Magnetic sensor. 

 
1.3 CIRCUIT DIAGRAM: 
 

Magnetic pickup (Proximity) sensor: 
 

 
 

Fig (b) – 1.1 Optical  
 

 

Fig (b) – 1.2 Photo Pickup 
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CONTROLS:  

 

1.  FRONT PANEL 
 

 POWER ON: 2 SPDT switch supplies the AC mains into the indicator. 
 

OPTICAL/PROXIMITY: This switch we can select the sensing device of optical/ proximity. 

 

2.  BACK PANEL 
 

SENSOR: 3 pin sockets are provided to connect the sensor to indicator. 
 

PROXIMITY: 3 pin sockets are provided to connect the sensor to indicator. 

 

POWER CABLE: 2 pin 2 core cable interconnects the 230 V -50Hz AC main into the AC main 

into the instrument. 
 

FUSE 500 mA fuse is used to protect the instrument from the short circuit. 
 

1.4 TABULAR COLUMN: 
 

S. No 
Optical / Photo Sensing 

Device Reading 

Proximity / Magnetic Sensing 

Device Reading 

1   

2   

3   

4   

5   
 

1.5 MODEL GRAPH: 

 

 

Fig – 1.3 Model Graph 

 

1.6 RESULT: 
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1.7 PRE LAB VIVA QUESTIONS: 
 

1. What is proximity sensor? 

2. What is optical sensor? 

 

1.8 POST LAB VIVA QUESTIONS: 
 

1. What are the applications of proximity sensor 

2. What are the applications of optical sensor 
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EXPERIMENT – 2 

CALCULATION OF DISTANCE AND LEVEL 

 

2.1 AIM:  

Distance measurement using ultrasonic transducer; Measurement of level using capacitive   transducer 
 

2.2 APPARATUS: 

 ST2312 trainer with power supply cord, 2mm Patch Cords (8 pieces) and Power Cord 
 

2.3 THEORY: 
 

Ultrasonic is defined as that band above 20 KHz. It continues up into the MHz range and finally, at 

around 1 GHz. Ultrasonic sensors (also known as transducers when they both send and receive) work on 

a principle similar to radar or sonar which evaluate attributes of a target by interpreting the echoes from 

radio or sound waves respectively. Ultrasonic sensors generate high frequency sound waves and 

evaluate the echo which is received back by the sensor. Sensors calculate the time interval between 

sending the signal and receiving the echo to determine the distance to an object. Ultrasonic sensors are 

active, visible, volumetric sensors. 

 

2.4  CIRCUIT DIAGRAM: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig – 2.1 Ultrasonic Transducer Traine 
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2.5 PROCEDURE: 

1. Connect the mains chord to Trainer. 

2. Make the Connection in the trainer as shown in figure. 

3. Switch ‘On’ the Power Supply. 

4. Keep the toggle switch at ‘1’ position as shown in figure. 

5. Connect a voltmeter as shown in the figure. 

6. Adjust the knob of Threshold Detector so the voltmeter reading becomes 4 V. 

7. Move any flat object up and down the ultrasonic sensors. Make sure that the object is parallel to the 

trainer. 

8. Observe the seven segment display as it shows the distance (in meters) between the ultrasonic 

sensors and the object 

 

2.6 PRECAUTIONS: 

1. Use the trainer kit with care. 

2. To avoid fire or shock hazards, observe all ratings and marks on the instrument. 

3. Do not operate in wet / damp conditions. 

 

2.7 RESULT: 

 

 

 

 

 

 

 

 

2.8 PRE LAB VIVA QUESTIONS:   

1. What is the difference between sensor and transducer? 

2. What are the features of ultra sonic waves? 

3. What is ultra sonic transducer? 

4. What is the function of ultra sonic sensors? 
 

2.9  POST LAB VIVA QUESTIONS: 

1. What is the frequency range of ultra sonic waves? 

2. How ultra sonic transducer works? 

3. What are the advantages of ultrasonic signals? 

4. What are the Characteristics of Transducer? 
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EXPERIMENT - 3 

(A) MEASUREMENT OF STRAIN AND PRESSURE 
 

 

3.1 AIM:  
 

           Strain measurement using strain gauge; Measurement of pressure using differential pressure transducer. 

 

3.2 APPARATUS: 

S. No Name of  Equipment Specifications 

1 Strain Gauge Trainer Kit Trainer Kit 

2 Pressure Sensor SPX3058D kit 

 

3.3 CIRCUIT DIAGRAM: 

Trainer Kit: 

 

 

 

 

Fig – 3.1 Circuit Diagram of Resistance Strain Gauge Strain  

Measurements and Calibration 
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3.4 PROCEDURE: 
 

1. Check connection made and Switch ON the instrument by toggle switch at the back of the box. The 

display glows to indicate the instrument is ON. 

2. Allow the instrument in ON Position for 10 minutes for initial warm-up. 

3. Adjust the ZERO Potentiometer on the panel till the display roads ‘OOP’. 

4. Apply load on the sensor using the loading arrangement provided in steps of 100g upto 1 Kg. 

5. The instrument display exact microstrain strained by the cantilever beam. 

6. Note down the readings in the tabular column. Percentage error in the readings. Hysteresic and 

Accuracy of the instrument can be calculated by comparing with the theoretical values 
 

3.5 TABULAR COLUMN: 
 
 

S. No. Weights 
Actual Reading 

(A) 

Indicating 

Reading(B) 

%error= 

A-b/a*100 

1     

2     

3     

4     

5     
 

3.6 MODEL CALCULATIONS: 
 

 S=(6pl) BT
2
E 

 P = Load applied in Kg (1 Kg) – 0.2 kg 

 L = Effective length of the beam in Cms. (22 Cms) 

 B = Width of the beam (2.8 Cms) 

 T = Thickness of the beam (0.25 Cm) 

 E = Young’s modulus (2X10
6
) 

 S = Micro strain 

 Then the micro strain for the above can be calculated as follows. 

 S = 
)102(25.08.2

2216
6XXX

XX
 

 S = 41077.3 X  

 S = 377 micro strain 
 

3.7  RESULT: 
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3.8 PRE LAB VIVA QUESTIONS: 

  

1. What is mean by strai? 

2. What are methods to measure the strain? 

3. What are units for strain? 

 
3.9 POST LAB VIVA QUESTIONS: 

 

1. What is meant by stress? 

2. What are applications of star in measurement? 

3. What is meant by calibration? 
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EXPERIMENT - 3 

(B) SPEED MEASUREMENT USING PROXIMITY SENSOR 

 

3.1 AIM:  
 

           Strain measurement using strain gauge; Measurement of pressure using differential pressure transducer. 
 

 

3.2      APPARATUS: 
 

 ST2308 Pressure Transducer Trainer, Pressure Vessel, Foot Pump  
 

3.3 CIRCUIT DIAGRAM: 
 

 

Fig (b) - 3.1  Pressure Transducer Trainer 

3.4 PROCEDURE: 

1. Fill the pressure vessel up to 90 psi (don’t cross the range) with the help of footpump, while filling 

be sure that the outlet valve is closed (Off Position). 

2. Connect the outlet (valve with lever) of the Pressure Vessel to any one of the inlet (either P1 or, P2) 

of the Pressure Transducer with the help of tube provided. 

3. Keep the other inlet (P1 or, P2) of the Transducer, so that the other pressure will be the Atmospheric 

pressure. 

4. Connect the circuit as shown in the figure 

5. Switch on the power of ST2308 Pressure Transducer Trainer 

6. Now, very slowly open the valve in order to release the pressure from the vessel and flow to the 

transducer’s input. 

7. Observe the DVM and Pressure Gauge, and note down the readings in observation table. 

8. Plot the Graph according to the readings 



Page | 19  

3.5 TABULAR COLUMN: 

S. No DVM Voltage (volts) Pressure Gauge (psi) 

1   

2   

3   

4   

5   

 

3.6 PRECAUTIONS: 

1. Use the trainer kit with care. 

2. To avoid fire or shock hazards, observe all ratings and marks on the instrument. 

3. Do not operate in wet / damp conditions 

4. Use the fuse type and rating specified for this instrument. 
 

3.7  RESULT: 

 

 

 

3.8 PRE LAB VIVA QUESTIONS: 

  

1. What is differential pressure? 

2. Which is the general reference pressure used? 

3. What is pressure? 

4. Describe the working principle of differential presure transducer. 

 
3.9 POST LAB VIVA QUESTIONS: 

 

1. Give some examples of applications of DPT? 

2. Which states of matter generally allow pressure measurement? 

3. What is signal conditioning? 

4. Give some units of pressure. 
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EXPERIMENT - 4 

MEASUREMENT OF POSITION AND LINEAR DISPLACEMENT 

 

4.1        AIM: 
 

 To measure the displacement using linear variable differential transformer. 
 

4.2 APPARATUS: 

S. No Name of  Equipment Specifications 

1 LVDT Trainer Kit 

 

4.3 CIRCUIT DIAGRAM: 

  1) LVDT trainer kit: 

 

 

 

Fig – 4.1 Circuit Diagram of LVDT and Capacitance Pickup –  

Characteristics and Calibration 
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4.4 MODEL GRAPH: 

 

 

Fig - 4.2 Output Voltage 
 

4.5 PROCEDURE: 

1. Connections are made as per the circuit diagram. 

2. Switch on the supply keep the instrument in ON position for 10 minutes for initial warm up. 

3. Rotate the micrometer core till it reads 20.0 mm and adjust the CAL potentiometer to display 10.0 

mm on the LVDT trainer kit. 

4. Rotate the micrometer core till it reads 10.0 mm and adjust the zero potentiometer to display 20.0 

mm on the LVDT trainer kit. 

5. Rotate back the micrometer core to read 20.0 mm and adjust once again the CAL potentiometer till 

the LVDT trainer kit display reads 10.0 mm. Now the instrument is calibrated for 10mm range. 

6. Rotate the core of micrometer in steps of 2 mm and tabulate the readings of micrometer, LVDT 

trainer kit display and multimeter reading. 

 

4.6  TABULAR COLUMN: 

S. No Micro meter Reading in MM Output Voltage 

1   

2   

3   

4   

5   

 

4.7 RESULT: 
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4.8 PRE LAB VIVA QUESTIONS: 

1. What is LVDT? 

2. What is transducer? 

3. How many transducers are there? 
 

4.9 POST LAB VIVA QUESTIONS 

1. How many windings the transformer in LVDT have in its construction? 

2. How the secondaries are connected in the transformer of LVDT? 
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EXPERIMENT - 5 

PHANTOM LOADING ON LPF WATTMETER 

 

5.1     AIM: 

 

To calibrate LPF wattmeter by phantom loading method and compare the power consumed with direct 

loading. 

 

5.2     APPARATUS: 

 

S. No Equipment Type Range Quantity 

1 Auto Transformer    

2 Voltmeter    

3 Ammeter    

4 LPF Wattmeter    

5 Connecting wires    
 

5.3 CIRCUIT DIAGRAM: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig – 5.1 Calibration of LPF Wattmeter by Phantom Testing 
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5.4        PROCEDURE: 

 

1. Keep the Autotransformer at zero position 

2. Make connections as per the Circuit diagram shown below.  

3. Switch on the 230 VAC, 50 Hz. power supply.  

4. Increase the input voltage gradually by rotating the Autotransformer in clockwise 

direction.  

5. Adjust the load rheostat so that sufficient current flows in the circuit. Please note that the current 

should be less then potentiometer rating.  

6. Note down the Voltmeter, Ammeter, Wattmeter for different voltages as per the tabular 

column.  

7. Find out the percentage error by using above equations.  

 

5.5 TABULAR COLUMN: 

 
 

S. No 
Voltage  

(V) 

Ammeter 

(A) 

Wattmeter  

(W) 
VI % Error 

1      

2      

3      

4      

 

5.6        MODEL CALCULATIONS: 

 

  % Error = (WM - WC) * 100/ WM 

                          Where   WC =VI 

5.7     RESULT: 

 

 

 

 

5.8 PRE LAB VIVA QUESTIONS: 

1. What is phantom loading? 

2. What is direct loading 
 

5.9 POST LAB VIVA QUESTIONS: 

1. Is direct or phantom loading is advantageous? 

2. -----------power is measured using phantom loading. 
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EXPERIMENT - 6 

(A) CALIBRATION OF SINGLE PHASE ENERGY METER AND POWER FACTOR 

METER 
 

6.1      AIM: 
 

To calibrate and testing of single phase induction type energy meter. 
 

6.2     APPARATUS: 

S. No Equipment Range Type Quantity 

1 Energy Meter    

2 Voltmeter    

3 Ammeter    

4 Resistive Load    

5 Stop Watch    

6 1-Ph Variac    

7 Connecting wires    
 

6.3     CIRCUIT DIAGRAM: 

 

Fig (a) – 6.1 Calibrations and Testing of Single Phase Energy Meter 

 

6.4       PROCEDURE: 

1. Keep the Autotransformer at zero position. 

2. Make connections as per the circuit diagram shown below 

3. Switch on the 230 VAC, 50 Hz, power supply. 
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4. Increase the input voltage gradually by rotating the Autotransformer in clockwise direction. 

5. Adjust the load rheostat so that sufficient current flows in the circuit. Please note that the current 

should be less than 4A. 

6. Note down the Voltmeter, Wattmeter and power factor meter readings for different voltages as per 

the tabular column. 

7. Note down the time (by using stop watch) for rotating the disc of the Energy Meter for 10 times. 

Find out the percentage error by using equations. 
 

6.5 TABULAR COLUMN: 
 

S. No 

Applied 

Load 

(A) 

Voltmeter 

Reading 

(V) 

Ammeter 

Reading 

(A) 

R=No of 

revolutions 

of the disc 

Time 

(sec) 
Es ET 

% 

Error  

1         

2         

3         

4         

 

6.6      MODEL CALCULATIONS: 

Energy meter constant K is defined as  

K=  No. of revolutions kwh  

                             KWH 

  Energy recorded by meter under test = Rx / Kx – kWh. 

  Energy computed from the readings of the indication instrument = kW x t  

  Where Rx = number of revolutions made by disc of meter under test. 

  Kx = number of revolutions per k Wh for meter under test. 

  KW = Power in kilowatt as computed from readings watt meter indicating instruments 

  t = time in hours. 

  Percentage Error = 100
)/(






tkW

tkWKxRx
 

 

6.7  RESULT: 

    

 

 

 

 

 



Page | 27  

6.8  PRE LAB VIVA QUESTIONS: 

1. What is the working principle of energy meter? 

2. What type of controlling torque is used in energy meter? 

3. What is the purpose of using shading band in energy meter? 

4. How does energy meter differ from a watt meter? 

5. What is the purpose of brake magnet in energy meter? 

6. How braking torque can be adjusted in energy meters? 
 

6.9 POST LAB VIVA QUESTIONS: 

1. What is your understanding of error in energy meter? 

2. Can you say on which parameters the energy meter error depends? 

3. What type of transformer is used in this circuit? 
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EXPERIMENT - 6 

(B) CALIBRATION OF DYNAMO METER TYPE POWER FACTOR METER 
 

6.1     AIM: 

    To calibrate dynamometer type power factor meter. 
 

6.2    APPARATUS: 

S. No. Equipment Range Type Quantity 

1 1-Phase Variac    

2 Power Factor Meter    

3 Ammeter    

4 Voltmeter    

5 Wattmeter    

6 Loads (1 - Ph)    

7 Connecting wires    
 

6.3    CIRCUIT DIAGRAM: 

 

Fig (b) – 6.1 Calibration of Dynamo Meter Type Power Factor Meter 
 

6.4     PROCEDURE: 

1. Keep the Auto transformer at Zero position 

2. Make connections as per Circuit diagram shown below. 

3. Switch on the 230 VAC, 50 Hz, Power supply. 

4. Increase the input voltage gradually by rotating the auto transformer in clockwise direction 220V. 

5. Adjust the load rheostat so that sufficient current flows in the circuit, Please note that the current 

should be less then 4A. 

6. Note down the Voltmeter, Ammeter, Wattmeter and power factor meter readings for different voltage 

as per the tabular column. 

7. Find out the percentage error by using equations. 
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6.5      TABULAR COLUMN: 

S. No 
Load 

Voltmeter 

Reading 

(V) 

Ammeter 

Reading 

(A) 

Wattmeter 

Reading 

(W) 

Power Factor 

Calculated (X) 

(CosØ= w/VI) 

PF Meter 

Reading 

(Y) 

% Error  

(X-Y) 

*100/Y R L 

1         

2         

3         

4         

5.         
 

6.6     MODEL CALCULATIONS: 

    Cos Ø (X) = W / VI 

    % Error =    
   

 
       

 

6.7     RESULT: 

 

 

 

 

 

 

 

 

6.8  PRE LAB VIVA QUESTIONS: 

1. What is power factor? 

2. Give expression for the PF. 

3. What is principle of power factor meter? 

4. What is the significance of power factor? 

5. What are the different types of power factor meters? 

6. Why is moving iron PF meters less accurate than dynamometer type? 
 

6.9 POST LAB VIVA QUESTIONS: 

1. What are the reasons for errors in power factor meters? 

2. What are the different remedies to reduce errors in power factor meters? 
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EXPERIMENT - 7 

MEASUREMENT OF TURNS RATIO AND APPLICATION OF CTs 

 
 

7.1 AIM:  
 

To find the turns ratio of transformer by using A.C bridge. 
 

7.2 APPARATUS:  

S. No Name of Equipment Quantity 

1 Transformer under test 1 

2 Transformer with adjustable range (standard) 1 

3 Zero position indicator( Digital AC Voltmeter) 1 

4 Applied voltage to the bridge and HV winding (220 V, 50 Hz) 1 

5 Induced voltage at the LV winding 1 
 

 

7.3 CIRCUIT DIAGRAM: 

 

 

Fig –7.1 Turns Ratio Diagram 

7.4 PROCEDURE: 

1. Make the connection as per the circuit diagram. 

2. Apply the supply to the high voltage side of the transformers. 

3. Change the tapping positions of transformer from 0v-14v and note the Ac voltmeter readings 

simultaneously. 

4. Calculate the turns ratio using below formulae. 
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7.5 TABULAR COLUMN: 
 

S. No Tapping Positions A.C. Bridge voltage 

1 0v  

2 10v  

3 11v  

4 12v  

5 13v  

6 14v  

 

7.6 MODEL CALCULATION: 

 Va – Vb = A.C. Bridge voltage 

  Where, Va – Voltage across secondary winding of transformer under test 

  Vb - Voltage across secondary winding of standard transformer.  

    Va = A.C. Bridge voltage + Vb 

  Hence turns ratio transformer under test, N1 / N2 = 230/Va 

 

7.7  RESULT: 

 

 

 

 

7.8  PRE LAB VIVA QUESTIONS: 

1. Define turns ratio of Transformer. 

2. Define transformation ratio of transformer. 

3. Which bridges used to measure the turns ratio? 
 

7.9 POST LAB VIVA QUESTIONS: 

1. Measurement of turns ratio is comparison method or substitution method? 

2. Name the detector used in the AC bridge. 

3. Write the formula for turns ratio. 
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EXPERIMENT - 8 

MEASUREMENT OF REACTIVE POWER 

 

 

8.1 AIM:  
 

To measure 3 - phase reactive power using single phase wattmeter. 

 

8.2 APPARATUS: 

S. No NAME OF COMPONENT RANGE TYPE QUANTITY 

1 Voltmeter    

2 Ammeter    

3 Wattmeter    

4 Inductive Load    

5 Three Phase Variac    
 

8.3 CIRCUIT DIAGRAM: 

 

Fig – 8.1 Circuit Diagram of Measurement of 3-Phase Reactive  

Power using Single Wattmeter 

8.4 PROCEDURE: 

1. Connect the circuit as shown in fig. 

2. Switch ‘ON’ the supply. 

3. Note down the corresponding there reading and calculate 3-phase  reactive power. 

4. Now increase the load of three phase Inductive load steps and note down the corresponding meter 

readings. 

5. Remove the load and switch ‘off’ the supply. 
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8.5 TABULAR COLUMN: 
 

3 Phase Load Wattmeter Reading 3 Phase Reactive Power 

1 A   

2 A   

3 A   

4 A   

5 A   

 

8.6 MODEL CALCULATIONS: 

  The total 3-ɸ reactive power is √3 VLIL sin ɸ 

 

8.7 RESULT: 

 

 

 

 

8.8  PRE LAB VIVA QUESTIONS: 

1. How do you measure power? 

2. State the difference between wattmeter and an energy meter. 

3. Types of wattmeters. 

4. Which types of wattmeter is widely used? 

5. How is the controlling torque obtained? 
 

8.9 POST LAB VIVA QUESTIONS: 

1. What are the errors in dynamometer type wattmeters? State a few? 

2. How many wattmeters do we require to measure 3-phase power? 

3. What is reactive power? State the formula? 

4. How many wattmeters are required to measure 3-phase reactive power? 

5. How do we minimize the errors due to eddy currents in wattmeters? 
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EXPERIMENT – 9 

NET METER 

9.1     AIM: 

             Study of bidirectional energy measurement using net metering. 

 

9.2     APPARATUS: 

 

 

 
 

Fig – 9.1 Net Meter 

9.3 CIRCUIT DIAGRAM: 

 

 

Fig – 9.2 Net Meter Evaluation Schematic 
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9.4        PROCEDURE: 
 

SYSTEM OVERVIEW AND WORKING PRINCIPLE Figure 1: Block diagram of the system. Figure 1 

shows the block diagram system in which two group of users are connected to the off grid Microgrid 

with the NEM. PV PANEL In our system for simulation purpose we used Solarex MSX64 solar panel is 

used which output 64 watt. The output of the solar panel depends on the solar irradiation. To make the 

solar panel to give constant power output we need to make that solar panel to work at some constant 

voltage and to make this we need to use MPPT controller [1]. NET ENERGY METER Net Energy 

Meter is a metering device that runs in both the directions depending on the electricity that is sent or 

received from the grid. In this Microgrid Net Energy Meter is connected between the groups of two 

users GP1 and GP2, if excess power is sent to the GP2 from GP1 through Macrogrid then this meter 

runs in one direction and if transmission is from GP2 to GP1 then the meter will run in opposite 

direction. INVERTER Inverter is a type of converter that converts DC input in to AC so that it can be 

transmitted through the AC transmission line. Inverter are of two types one is single phase and another 

is three phase. Here in this system single phase inverter is used with MPPT controller. Maximum Power 

Point Tracking is used to get the maximum power output from the PV Panel. In this system MPPT 

control using Perturb and Observe Method is used as it is efficient and easy one [3] [5]. MICROGRID 

Microgrid is the combination of various distributed energy resources that forms a complete energy 

system used to balance the captive supply and demand resources to maintain stability of service within 

specified boundary. Microgrids are of many types such as Campus Microgrid, Community Microgrids, 

Off Grid Microgrid and etc. here the Microgrid is of Off Grid Microgrid that helps the villages those are 

not connected to the utility grid[2][4]. When the electricity is fed to the Microgrid the synchronization 

between the grid and the feeder is not required as it is a single phase and the grid has no electricity until 

GP1 or GP2 feeds to it. 

 

WORKING PRINCIPLE: Working principle of the Net Energy Meter is shown in terms of the flow 

chart. When the system starts first it checks for any of the control signals C1 or C2 is ON or not. If C1 is 

on it means that there is a request from GP2 to GP1 for the supply of Electricity and if C2 is on then 

there is request from GP1 to GP2 for the electricity. Once the control signals are checked, if any of the 

control signal is on then it calculates the Voltage V1 or V2, Current I1 or I2, and Time T1 or T2. After 

this it calculates the Power P1 or P2 and the amount power consumed by the customer in terms of Units 

using the below shown formula 
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Fig – 9.3 Flow Chart 
 

Now consider that the control signal C1 is ON and there is request from GP2 to GP1, then power in 

terms of Units is given as, Where, Ps is the Power output from PV panel at 1000 Wh/m2 irradiation. P1 

is the power fed to the Microgrid from GP1. T1 is period in which the electricity is fed to the Microgrid. 

Now the amount that is to be paid is calculated using the formula. The input to the NEM is the Current, 

Voltage, Time (Period) and the control signal from the GP1 or GP2. The output from the solar panel is 

fed to the inverter where the DC is converted to AC and it is boosted to 230V so that is can be 

transmitted through Microgrid easily. When one of the control signal is ON then the Net Energy Meter 

will read the required values from GP1 or GP2 and calculated the net electricity usage and the net wages 

the is to be paid at the end of each month. To calculate the period a digital clock is added that takes the 

complete time taken for the simulation and makes the calculation. The figure 3 shows the simulation of 

the NEM in the MATLAB Simulink function editor. The output will be the Net amount that is to be paid 

and whether GP1 has to pay or GP2 has to pay will depend on the sign of the output of Net Energy 

Meter. 
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Fig – 9.4 Simulink Diagram 

As a developing country it is must for India to power those unpowered villages, for this it is best to go 

towards the Distributed Energy Resources like solar and implement these solar panels as the rooftop 

systems to avoid energy crisis. In this context this system will provide an easiest way for villagers to get 

powered by the natural resource which is abundantly available and monitor their usage using Net 

Energy Meter where whole system is called as the Off Grid Microgrid system. 

 

9.5    RESULT: 

 

 
 

 

 

9.6  PRE LAB VIVA QUESTIONS: 

1. What is net metering? 

2. Why would I want to get involved in net metering? 

3. What types of generating facilities are eligible for net metering? 

4. How long has net metering been available? 
 

9.7 POST LAB VIVA QUESTIONS: 

1. Does the Commonwealth regulate net metering? 

2. Why are there different caps?  How much net metering is allowed in Massachusetts? 

3. What is a net metering tariff? 

4. Where can I find my company’s net metering tariffs? 

http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#What is net metering?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#Why would I want to get involved in net metering?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#What types of generating facilities are eligible for net metering?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#How long has net metering been available?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#Does the Commonwealth regulate net metering?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#Why are there different caps?  How much net metering is allowed in Massachusetts?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#What is a net metering tariff?
http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#Where can I find my company’s net metering tariffs?
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EXPERIMENT - 10 

MEASUREMENT OF FREQUENCY AND THD USING DIGITAL SIMULATION 

 

10.1     AIM: 

              Determination of frequency and Total Harmonic Distortion (THD) using LabVIEW 
 

10.2   APPARATUS: 

Primary Software:  

Primary Software Version: 2011 

Primary Software Fixed Version: N/A 

Secondary Software: N/A 

Hardware: Multifunction DAQ (MIO)>>Basic>>DAQPad-6015 for USB 

 

Problem:  

How can I perform a simple frequency measurement with an analog input channel? 

 

Solution:  
 

Some data acquisition cards can have limited counter input capabilities, limited FIFO buffers, no Direct 

Memory Access (DMA) and/or do not support the AI Frequency task type and thus cannot provide high 

Frequency measurements. 

 

A simple workaround in these cases would be to acquire the signal as an analog input, then perform 

some spectral analysis. In the attached VI, built on top of the shipping example ContAcq & Graph 

Voltage-Int Clk, the analog signal acquired by the DAQmx Read is wired into the Tone Measurements 

Express VI,  which calculates the signal's frequency. Similarly, the Spectral Measurements Express 

VI is used to obtain the signal's Power Spectrum. These two pieces of information are crucial for any 

frequency domain analysis. 
 

10.3  CIRCUIT DIAGRAM: 

 
 

Fig – 10.1 Simulink Diagram 

 

http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/tone_measurements/
http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/tone_measurements/
http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/spectral_measurements/
http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/spectral_measurements/
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Related Links:  

White Paper: Frequency Measurements: How-To Guide 

LabVIEW Help: Tone Measurements Express VI  

LabVIEW Help: Spectral Measurements Express VI 

 

Attachments:  

Simple Analog In Freq Meas.vi 
 

 

Report Date: 11/18/2005 

Last Updated: 08/19/2015 

Document ID: 3RH83JJQ 

Your Feedback!  Poor  |  Excellent     Yes No 

 Document Quality?  

 

 

     
  Answered Your Question?  

 

 

  

  1 2 3 4 5 

    

 

Please Contact NI for all product and support inquiries. 
 

 

 

10.4    PROCEDURE: 
 

Harmonic Distortion Measurement 

Publish Date: Mar 15, 2016 | 5 Ratings | 3.40 out of 5 | Print 

Overview 
 

Harmonic distortion is a measure of the amount of power contained in the harmonics of a fundamental 

signal. Harmonic distortion is inherent to devices and systems that possess nonlinear characteristics—

the more nonlinear the device, the greater its harmonic distortion. 

 

Table of Contents 

 
1. Measuring Harmonic Distortion 

2. Understanding the RF Vector Signal Analyzer (VSA) Harmonic Distortion Limits 

3. Choosing an Optimal Setting for the RF VSA 

4. Related Products 

 

1. Measuring Harmonic Distortion 

Harmonic distortion can be expressed as a power ratio or as a percentage ratio. Use the following 

formula to express it as a power ratio: 

http://zone.ni.com/devzone/cda/tut/p/id/7111
http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/tone_measurements/
http://zone.ni.com/reference/en-XX/help/371361K-01/lvexpress/spectral_measurements/
http://digital.ni.com/public.nsf/$CXIV/ATTACH-AEEE-9ZJNUF/$FILE/Simple%20Analog%20In%20Freq%20Meas.vi
https://www.ni.com/contact-us/
javascript:window.print()
http://www.ni.com/white-paper/3401/en/#toc1
http://www.ni.com/white-paper/3401/en/#toc2
http://www.ni.com/white-paper/3401/en/#toc3
http://www.ni.com/white-paper/3401/en/#toc4
javascript:validate()
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where PHD is the power of the harmonic distortion in dBc, Pfund is the fundamental signal power in 

dB or dBm, and Pharm is the power of the harmonic of interest in dB or dBm. 

Convert the powers to voltages to express harmonic distortion as a percentage ratio: 

 

 

 

In some applications, the harmonic distortion is measured as a total percentage harmonic distortion 

(THD). This measurement involves the power summation of all the harmonics in the spectrum band, 

defined in the following equation: 

 

 

 

A typical setup to perform a harmonic distortion measurement is shown in the figure below. A 

single tone is generated by the PXI-565x RF Signal Generator, with this signal then passed through 

a low pass or band pass filter to suppress any harmonics. This setup injects a very clean sinusoidal 

signal into the unit under test (UUT) so that any harmonic content at the UUT output can be 

assumed to be generated by the UUT instead of the signal source. 

 

 

Fig – 10.2 Typical Harmonic Distortion Measurement Setup 

 

 2.  Understanding the RF Vector Signal Analyzer (VSA) Harmonic Distortion Limits 

As with all analyzers, there are residual distortions inherent in the RF VSA. It is important that these 

distortions do not corrupt your measurement. 
 

The level of internal distortion is a function of the linearity of the system, which is primarily 

determined at the input mixer. Increasing input power at the mixer increases distortion, so if the 

input signal is too high, the internally generated harmonics can overwhelm the harmonics of the 

original signal. 
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The specifications for the second- and third-order harmonic intercept points provide sufficient 

information about the linearity of the system. For example, to measure a second-order harmonic at –

70 dBc, the fundamental power at the mixer input has to satisfy the following condition: 

 

 

where IIP2 is the second-order intercept point. 

If the input signal power is greater than this value, the signal must be attenuated before the first 

mixer. There is an upper limit on the amount of attenuation you can switch in because the noise 

floor rises by the same amount as the attenuation. To lower the noise level decrease the resolution 

bandwidth, but keep in mind that there is also a practical lower limit on the resolution bandwidth. 

Decreasing the resolution bandwidth increases measurement time. 
 

The harmonic distortion dynamic range (HDDR) indicates the minimum distortion the RF VSA can 

measure, which is about –96 dBc/Hz for the RF VSA. 
 

3.    Choosing an Optimal Setting for the RF VSA 
 

Because the level of harmonic distortion is often unknown, the optimal attenuation level can be 

difficult to determine. Complete the following steps to find the proper attenuation setting for the RF 

VSA: 
 

1. Set the attenuation so that the input power at the mixer is about –30 dBm. When using the RF 

Signal Analyzer Demo Panel, mixer level = reference level – attenuation. 

2. Tune to the harmonic frequency of interest and then decrease the resolution bandwidth until the 

harmonic spur appears. 

3.  Increase the attenuation level. If the harmonic spur decreases, attenuate more. 

4. Repeat step 3 until the harmonic level does not decrease any further. Attenuation does not lower 

the harmonics of the original signal; it only lowers the internally generated ones. 

5.  Decrease the resolution bandwidth to lower the noise floor. 
 

This setting is the optimal attenuation setting. 
 

10.5   RESULT: 

 

 

 

10.6  PRE LAB VIVA QUESTIONS: 
 

1. Define frequency 

2. What are the units of frequency 

3. What is time period 
 

10.7 POST LAB VIVA QUESTIONS: 

1. Define THD 

2. How can you measure frequency THD 

http://www.mass.gov/eea/grants-and-tech-assistance/guidance-technical-assistance/agencies-and-divisions/dpu/net-metering-faqs.html#Does the Commonwealth regulate net metering?
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EXPERIMENT – 11 

ANALYSIS OF ALTERNATING QUANTITIES USING DIGITAL SIMULATION 

11.1 AIM:  

 

Measurement and display of voltage and current wave forms and analysis of waveforms using                

LabVIEW. 
 

11.2 Circuit Diagram: 

 

 
 

 
 

Fig – 11.1 Simulink Diagram 
 

11.3 PROCEDURE: 

National Instruments Page 1 LabVIEW Tutorial on Spectral Analysis LabVIEW Tutorial on Spectral 

Analysis With the LabVIEW graphical programming environment, you can quickly and easily create 

many different types of measurement analysis applications. LabVIEW has built-in functions for 

measurement analysis including RMS calculation, peak detection, harmonic analysis, filtering, and 

frequency analysis functions, as well as a large number of complex mathematical and statistical 

functions. Purpose: In this tutorial, you will create a LabVIEW virtual instrument (VI) that generates a 

sine wave, uses one of the LabVIEW analysis functions to calculate the power spectrum of the signal 

with a Fast Fourier Transform (FFT), and creates a plot of the frequency spectrum. Completion Time: 

This tutorial will take approximately 45 minutes. Programming Level: This tutorial is designed for 

LabVIEW users of any level. However, if this is your first time using LabVIEW, consider starting out 
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with our introductory tutorial entitled “Acquire, Analyze, and Present with LabVIEW”. It contains 

detailed information about the fundamentals of graphical programming, so you can quickly become 

familiar with the LabVIEW environment. You can find it at http://www.ni.com/tutorials. If you would 

like more in-depth technical information about spectral analysis, the National Instruments Web site 

offers a multimedia-based “FFT Interactive Tutorial” on the fundamentals of frequency domain 

measurements. It can also be found at http://www.ni.com/tutorials. Follow these steps to create your 

own VI: 1.) Open your internet browser and enter http://www.ni.com/info. Enter “trylvnow” as the info 

code. 2.) If you have already created a profile, enter your e-mail address and password and click 

“Continue”. If not, creating one will only take a few seconds; to begin, simply select “No. I need to 

create a profile” and click “Continue”. Once you have created your profile, move on to step 3. 3.) Click 

on the “Start LabVIEW” button. A pop-up window will instruct you to do a one-time installation of a 

small client. 4.) From the LabVIEW 6.1 splash screen, choose New VI. This will open up two blank 

windows. The gray window titled “Untitled 1” is the front panel and will be your user interface, and the 

white window titled “Untitled 1 Diagram” is the block diagram, where you will create your graphical 

source code. 5.) Click on the front panel window and create the user interface shown below by 

performing steps 6-10. *USAGE TIP: You may also access the front panel by selecting Window»Show 

Panel from the block diagram menu bar. National Instruments Page 2 LabVIEW Tutorial on Spectral 

Analysis 6.) Click on the Controls palette window on the left side of the screen. The Controls palette 

contains objects (i.e. controls and indicators) that can be placed on the front panel to form the user 

interface. Mouse over the subpalettes and you will see their descriptions in the top of the window. 

*USAGE TIP: If you cannot see the Controls palette, you can view it by selecting Window»Show 

Controls Palette from the menu or by right-clicking on a blank area on the front panel window. 

*DEFINITION: A control is a front panel object that serves as a data source, getting data from the user 

via the front panel and sending it to the block diagram code (e.g. a knob). An indicator is a front panel 

object that serves as a data sink, obtaining data from the block diagram code and displaying it to the 

front panel (e.g. a graph). A front panel object cannot be both a control and an indicator. 7.) From the 

Controls palette, select the Numeric sub-palette and click on the Dial control as shown in the figure 

below. Move the mouse to the front panel and click the left mouse button to drop the Dial onto the 

panel. National Instruments Page 3 LabVIEW Tutorial on Spectral Analysis *USAGE TIP: You can 

reposition the Dial control on the panel by clicking and dragging with the positioning tool, shown as an 

arrow on the Tools palette. To select the positioning tool, either click on it in the Tools palette or press 

the key to switch the currently selected tool until the positioning tool is shown. *USAGE TIP: If you 

cannot see the Tools palette, select Window»Show Tools Palette from the menu. 8.) From the Numeric 

sub-palette, choose the Digital Control, and drop it onto the front panel. 9.) Click on the up arrow at the 

top of the Numeric sub-palette window to go back to the Controls palette, as shown below. 10.) From 

the Controls palette, select the Graph sub-palette and click on the Waveform Graph as shown below. 

Place it onto the front panel. National Instruments Page 4 LabVIEW Tutorial on Spectral Analysis 

*DEFINITION: The Waveform Graph is an indicator that accepts an array of data values and plots the 

entire array at once. This is different from the Waveform Chart, which scrolls data continuously, adding 

new data points to those already displayed. The next step is to create the initial block diagram code. 

Build the block diagram pictured below by performing steps 11-28. 11.) Click on the block diagram 

window (behind the front panel). You should see three nodes on the block diagram. These nodes 

correspond to the three objects already placed on the front panel. *INFO TIP: The two control nodes 

(Dial and Numeric) have small black arrows on the right, and the Waveform Graph indicator has a 

similar arrow on the left. These arrows indicate the direction of data flow, either into or out of the node. 

All of the nodes are orange, indicating that they represent floating-point values, and they all contain the 
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letters DBL, indicating that they are double precision. 12.) Note that after clicking on the block diagram 

window, the Controls palette has been replaced by the Functions palette. The Functions palette is used 

to National Instruments Page 5 LabVIEW Tutorial on Spectral Analysis build the block diagram. It 

contains all of the LabVIEW functions that can be combined to create your custom application. 13.) 

Reposition the Functions palette so that you can view the entire window on your screen. *USAGE TIP: 

If you cannot see the Functions palette, you may show it manually by selecting Window»Show 

Functions Palette from the menu. 14.) Within the Functions palette, select the Waveform sub-palette as 

shown below. This palette contains functions performed on the waveform data type. The waveform data 

type is a unique feature of LabVIEW. It is a special kind of cluster that succinctly contains both 

amplitude and timing information of a signal. *DEFINITION: A cluster is a data type that bundles 

together many different kinds of information, similar to several wires carrying various types of data 

wrapped together as one. This is also similar to the structure used in text-based programming languages. 

*DEFINITION: The waveform data type consists of a cluster of three elements. These three elements 

are an array of Y values containing the signal amplitude, a single value t0 that represents the start time 

of the signal, and a single value dt that represents the time interval between data points in the Y array. 

When the waveform data type is passed to the Waveform Graph, the graph interprets the data and plots 

the timing information on the X-axis along with the array of amplitudes on the Y-axis. National 

Instruments Page 6 LabVIEW Tutorial on Spectral Analysis 15.) Within the Waveform palette, select 

the Waveform Generation menu. The functions in this menu automatically generate many commonly 

used waveforms. 16.) Choose the Sine Wave.vi and drop it onto the block diagram. *USAGE TIP: If 

you would like more information on how Sine Wave.vi or any other VI works, simply activate the 

Context Help by selecting Help»Show Context Help or by pressing . Put the mouse pointer on any 

object in the block diagram, and the context help window will give a description of that VI or object. 

For additional in-depth information about a VI click on the “Click here for more help” button inside the 

Context Help window to open the LabVIEW Help page for that item. The LabVIEW Help page contains 

specific information about each input and output and about the function of the VI. You can also view 

the front panel and/or block diagram of the SineWave.vi by double-clicking on the node or right-

clicking on it and selecting Open Front Panel. 17.) From the same Waveform Generation menu, choose 

the Uniform White Noise Waveform.vi and place it on the block diagram. 18.) Using the wiring tool 

(shown as a spool of wire in the Tools palette), place the mouse over the Sine Wave.vi and notice that 

the input and output terminals appear on the edges of the VI icon. The input or output terminal that the 

wiring tool is currently pointing to blinks on the block diagram as well as in the Context Help window 

(press ), and its label is displayed in a tip-strip. 19.) Select the ‘frequency’ input by clicking on the upper 

left input terminal. A broken wire will now trail the mouse as you move it. 20.) Click on the Dial control 

and notice that a solid orange wire has been connected from the Dial control node to the Sine Wave.vi 

‘frequency’ input. The orange color of the wire symbolizes a floating-point value. *USAGE TIP: You 

can click the left mouse button anytime during wiring to lock the current position of the wire onto the 

screen. Then you can move the mouse up or down to better control how the wire is placed. You can also 

move wires around by clicking and dragging them with the positioning tool (arrow). To cancel the 

placement of a wire, click the right mouse button during wiring or highlight the undesired wire and 

press . To eliminate all broken wires on the block diagram at once, press .  

The VI will not run if there are broken wires present in the block diagram. 21.) Rename the Dial control 

by double-clicking on the label with the labeling tool (capital “A”). This will highlight the label, 

allowing you to type in new text. Change the label to “Frequency (Hz)”, since this dial has been wired 

to control the frequency input to the Sine Wave.vi. 22.) Using the same method explained in steps 19-21 
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above, wire the ‘amplitude’ input of the Sine Wave.vi to the Numeric digital control node and change 

the label of the Numeric control to “Amplitude.” 23.) With the wiring tool, right-click on the 

‘amplitude’ input of the Uniform White Noise Waveform.vi and select Create»Constant as shown 

below. The default amplitude of the noise is 1.00. You can change this value by doubleclicking on it 

with the labeling tool (capital “A”) and typing in a new number. For this example, we will use the 

default value. National Instruments Page 7 LabVIEW Tutorial on Spectral Analysis *DEFINITION: A 

constant exists only on the block diagram and cannot be changed while the VI is running. This is 

different from a control, which exists on the front panel and can be changed at any time by the user. 24.) 

From the Waveform Generation palette, click the Up arrow at the top left of the window (described in 

step 9) to go back to the Waveform palette. 25.) From the Waveform palette, choose the Waveform 

Operations menu. Click on the Add Waveforms.vi and place it onto the block diagram. 26.) Using the 

wiring tool, connect the ‘signal out’ output of the Sine Wave.vi to the upper left ‘waveform A’ input of 

the Add Waveforms.vi 27.) Connect the ‘signal out’ output of the Uniform White Noise Waveform.vi to 

the ‘waveform B’ input of the Add Waveforms.vi. 28.) Connect the ‘result’ output terminal of the Add 

Waveforms.vi to the Waveform Graph indicator node. Notice that the wire used to connect these two is 

wide and brown in color. This type of wire represents a cluster, more specifically, the waveform data 

type cluster discussed previously. At this point, you have created a working VI that generates a 

waveform containing a noisy sine wave and plots it on a Waveform Graph. If everything is wired 

correctly, you will see a white Run arrow button as the first button in the toolbar at the top of the front 

panel and block diagram windows. If the arrow is gray and broken, follow the debugging instructions in 

the tip below. If the Run arrow is solid white, there are no errors and you can now run your VI. 

*DEBUGGING TIP: If the Run arrow is broken, click on the broken Run arrow to view the error list. 

Click on an error description to highlight it and read the details given in the Details window to help 

solve the problem. Then, click the Show Error button. This will clearly show the problematic area on the 

block diagram. 29.) Go to the front panel and enter values for the frequency and amplitude of your sine 

wave using the operating tool (hand) to click and drag the dial and National Instruments Page 8 

LabVIEW Tutorial on Spectral Analysis to increment or decrement the digital control arrows. Set the 

frequency to 2.0 Hz and the amplitude to 5.00. *USAGE TIP: You can enter a value directly into the 

digital control by double-clicking the number in the field and typing in a new number. *USAGE TIP: 

To more precisely set the value of the frequency dial, right-click on the dial, select Visible Items and 

choose Digital Display. This will bring up a numeric window where you can view or change the dial 

value digitally. 30.) Run the VI by clicking the Run arrow. On the front panel you should see a noisy 

sine wave with the proper frequency and amplitude plotted on the Waveform Graph, as shown in the 

figure below. If you do not see this, be sure to check that you have entered non-zero values for the input 

frequency and amplitude and that your block diagram mimics the figure given above. Now that we have 

generated the noisy sine wave, the next step is to perform the frequency spectrum analysis. LabVIEW 

makes this very easy by providing a built-in FFT Power Spectrum function. Create the block diagram 

code pictured below to calculate and plot the power spectrum of the noisy sine wave by performing 

steps 31-45. National Instruments Page 9 LabVIEW Tutorial on Spectral Analysis 31.) Switch to the 

block diagram and delete the wire connecting the Add Waveforms.vi to the Waveform Graph node by 

highlighting it with the positioning tool and pressing . 32.) Click the Up arrow on the Waveform 

Operations palette to go back to the Waveform palette. Choose the Waveform Measurements menu. 

Inside this menu, select the FFT Power Spectrum.vi as shown below, and drop it onto the block 

diagram. *INFO TIP: In general, the FFT Power Spectrum.vi accepts any waveform as an input and 

sends the computed power spectrum of the waveform to the output. The parameters used to determine 

the power spectrum are changeable, including the time-domain window type, the specific averaging 
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method, and the units applied to the output. Use the Context Help window () to read more about how 

this VI works, or look at the underlying code by double-clicking on the VI to view its contents. National 

Instruments Page 10 LabVIEW Tutorial on Spectral Analysis 33.) Place the wiring tool on the FFT 

Power Spectrum.vi icon to view the input and output terminals. 34.) Connect the ‘time signal’ input of 

the FFT Power Spectrum.vi to the ‘result’ output of the Add Waveforms.vi. 35.) Connect the ‘power 

spectrum’ output of the FFT Power Spectrum.vi to the Waveform Graph indicator node. Notice that the 

wire connecting the FFT Power Spectrum.vi to the Waveform Graph is pink. The pink color in this case 

denotes a general cluster data type. *DEFINITION: The Waveform Graph node itself has also changed 

from brown to pink. This graph is polymorphic, meaning that it accepts many different types of data, 

including waveforms, clusters, and arrays. The ability to use polymorphic functions is a feature of 

LabVIEW that provides versatility in your programming by not restricting you to traditional, explicit 

type casting rules. Next, we will add a While Loop to run continuous iterations of the sine wave 

generation and frequency analysis. This is necessary in order to utilize the averaging features of the FFT 

Power Spectrum.vi. 36.) From the Waveform Measurements palette, click the Up arrow twice to go 

back to the general Functions palette. 37.) Select the Structures sub-palette and choose the While Loop 

structure. Then, place the While Loop around the existing code by clicking and holding down the mouse 

button at the upper left corner of the block diagram window and dragging the box to enclose the entire 

diagram. 38.) Go to the front panel. Click the Up arrow until you see the general Controls palette. 39.) 

Select the Boolean sub-palette, and choose the STOP button. Drop the STOP button onto the front 

panel. *USAGE TIP: It is important to always have a way to stop any loops that you create in 

LabVIEW. The STOP button is the best way to easily control while loops. 40.) Go back to the block 

diagram and locate the STOP button node. Use the positioning tool to drag this node into the while loop, 

if it is not already there. 41.) Right-click on the continuation terminal (green circular arrow) of the while 

loop in the bottom right corner and select Stop if True, as shown below. You will see the terminal 

change from a green arrow to a red stop sign. National Instruments Page 11 LabVIEW Tutorial on 

Spectral Analysis 42.) Wire the STOP button node to the continuation terminal with the wiring tool. 43.) 

Go to the front panel and change the range of the frequency dial to 0-500 Hz using the labeling tool 

(capital “A”). Double-click on the highest dial value marker and type “500.” Press Enter or click on the 

check box at the upper left corner of the window to confirm your entry. 44.) With the labeling tool, 

double-click on the ‘Time’ label for the X-axis of the Waveform Graph and change it to ‘Frequency.’ 

45.) Set the dial to 200 Hz using the operating tool. 46.) If the run arrow is solid white and there are no 

errors in the block diagram, run the VI and observe its behavior. You should see a plot of the power 

spectrum on the Waveform Graph, with a spike in the plot at the frequency designated by the Dial 

control, as shown below. Turn the dial and notice the movement of the frequency spike. 47.) Push the 

STOP button to stop the VI and continue editing. *DEBUGGING TIP: Note that the VI now must be 

stopped using the STOP button. If the Run arrow is solid black, the VI is still running and must be 

stopped before it can be edited. National Instruments Page 12 LabVIEW Tutorial on Spectral Analysis 

The FFT Power Spectrum.vi has built-in averaging capabilities to display the running average of 

multiple power spectrum calculations. To add these averaging capabilities and other features to your 

spectral analysis VI, modify your block diagram as shown below by performing steps 48-53. 48.) Go to 

the block diagram and place the wiring tool over the ‘window’ input of the FFT Power Spectrum.vi. 49.) 

Right-click and select Create»Control. This will create a ‘window’ control node on the block diagram 

and will automatically wire it to the terminal National Instruments Page 13 LabVIEW Tutorial on 

Spectral Analysis from which it was created. It will also place a new control on the front panel. 50.) Use 

the positioning tool to click on the ‘window’ node and move it away from the other input terminals. Be 

sure when you are moving objects to highlight the entire object, not just the label. 51.) Locate the new 
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ring control on the front panel (it may be off the screen below). Use the positioning tool to click on the 

‘window’ control and drag it to a better location near the other front panel objects. 52.) Repeat the above 

steps to create controls for the ‘averaging parameters’ input, and the ‘dB On’ input. Doing this will add 

to the front panel a cluster control with elements specifying the ‘averaging parameters’, as well as a 

vertical slide switch control for ‘dB On’. 53.) Set the front panel to the parameters shown below and run 

the VI. Congratulations! You have created a fully functional sine wave spectral analyzer virtual 

instrument. Try adjusting the different averaging methods, the number of averages, and the windowing 

properties to see how they affect the power spectrum output. You can bring any signal type into the 

provided LabVIEW signal analysis functions, whether the signal is generated, like the noisy sine wave 

in this example, or measured with hardware and acquired through the PC for your particular application. 

This example gives a small sample of the many powerful National Instruments Page 14 LabVIEW 

Tutorial on Spectral Analysis tools that LabVIEW has to offer and demonstrates the ease with which 

you can create your own custom signal analysis applications. 

11.4 RESULT: 

 

 

11.5  PRE LAB VIVA QUESTIONS: 

1. What is current? 

2. Ohm’s law is valid for what type of circuit? 

3. What are the limitations of ohm’s law? 
 

11.6 POST LAB VIVA QUESTIONS: 

1. What is Kirchoff’s law? 

2. What is Kirchoff’s current law (KCL)? 

3. What is Kirchoff’s voltage law (KVL)? 

 

 

 

 

 

 

 



Page | 48  

EXPERIMENT – 12 

TWO WATTMETER METHOD USING DIGITAL SIMULATION 

 

12.1 AIM:  

 

Measurement of real and reactive powers of an electrical load using two wattmeter method and 

verification using LabVIEW. 

 

12.2 APPARATUS: 
 

Table of Contents: 
 

1. NI Hardware for Measuring Current 

2. Making the Physical Connections for Current Measurement 

3. Sensors and Front End Components for Measuring Voltage and Current 

4. Current Sensor and Transformer Vendors 

5. NI Hardware for Measuring Voltage 

6. Power Calculations from Voltage and Current Waveforms 

7. Recommended System Components by Application 

8. Selecting a Current Measurement Sensor 

9. Compact RIO and Compact DAQ Resources 

10. Additional Resources 
 

12.3  PROCEDURE 

1. NI Hardware for Measuring Current 

From an instrumentation standpoint, current measurements are made with front end conditioning or 

sensors such as shunts, current transformers (CT), hall-effect sensors, and Rogowski coils.  NI has a 

variety of hardware options for both direct measurement with a module and connection to external 

sensors and conditioning equipment.  Table 1 shows modules compatible with Compact RIO chassis 

and Compact DAQ chassis for current measurement and Voltage measurement modules from tables 

1 and 2 respectively are synchronized when installed together in either a Compact DAQ or Compact 
RIO chassis. Channel synchronization is needed for more accurate phase and power measurements. 

  

Model Number 
Measurement 

Range 
Current Measurement Method 

NI 9239 / NI 9229 ±10 V/±60 V Connect to current sensors with ±10V or ±60V output 

NI 9238  ±0.5 V 
Connect to current sensors with 0.333 VRMS output 

and external shunts 

NI 9227  5 ARMS 
Direct connection to module that has internal, 

calibrated shunts 

http://www.ni.com/white-paper/8198/en/#toc1
http://www.ni.com/white-paper/8198/en/#toc2
http://www.ni.com/white-paper/8198/en/#toc3
http://www.ni.com/white-paper/8198/en/#toc4
http://www.ni.com/white-paper/8198/en/#toc5
http://www.ni.com/white-paper/8198/en/#toc6
http://www.ni.com/white-paper/8198/en/#toc7
http://www.ni.com/white-paper/8198/en/#toc8
http://www.ni.com/white-paper/8198/en/#toc9
http://www.ni.com/white-paper/8198/en/#toc10
http://sine.ni.com/nips/cds/view/p/lang/en/nid/208797
http://sine.ni.com/nips/cds/view/p/lang/en/nid/208796
http://sine.ni.com/nips/cds/view/p/lang/en/nid/212512
http://sine.ni.com/nips/cds/view/p/lang/en/nid/208794
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NI 9246  20 ARMS 
Direct connection to module that has internal, 

calibrated CTs; OR connect to 1 A and 5A secondary 

from high current CTs 

NI 9247  

50 ARMS (100 

ARMS for 10 

seconds) 

Direct connection to module that has internal, 

calibrated CTs; OR connect to 1 A and 5A secondary 

from high current CTs 
 

Table - 12. 1 NI has a variety of C Series modules for current measurement.  All modules output 

full waveform for processing with LabVIEW or other measurement and analysis software. 

  

 

 

  

Figure - 12.1 The NI 9229, NI 9239, NI 9227, and NI 9238 have a two terminal connector (left) for 

each measurement channel.  Shields are available (right), and recommended, for strain relief and 

operator keep-outs from connections to active circuits. 

  

 

 

 

Figure - 12.2 The NI 9246 and NI 9247 modules have CTs built into the module, large over-

current ratings, and accommodate up to 10AWG wire with ring lugs for higher current 

measurement.  Direct measurements with these modules will be more accurate and with a higher 

frequency response than using most external CTs/sensors.  Both modules can withstand 500 

ARMS for 1 second and 1250 ARMS for 1 cycle. 

  

http://sine.ni.com/nips/cds/view/p/lang/en/nid/213202
http://sine.ni.com/nips/cds/view/p/lang/en/nid/213199
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2.  Making the Physical Connections for Current Measurement 

The following illustrations show how to physically connect modules to a circuit for current 

measurement.  A power strip connected to a residential outlet is used for demonstration purposes 

but this concept scales from individual appliances on residential service levels (120VAC/240VAC), 

all the way to utility voltages.  NOTE:  Utility distribution and transmission levels will always use 
external sensors (CTs/PTs). 

 

Figure – 12.3 For direct module connection, the load wire (black in the US), is cut and connected 

to the AI+ and AI- terminals of a single channel.  Current passing through the module is 

measured.  In the image above with the splice in the cable, the module will measure the current 

flowing to all devices plugged into the power strip. 

 

Figure – 12.4 For module measurement using a CT, the load wire (black in the US), is passed 

through the opening of the CT either via a split core CT or cutting/re-splicing the wire.  The leads 

from the CT are then connected to the AI+ and AI- of the measurement module.  The module will 

measure all current on the line that is routed through the CT opening.  Scaling is done in software 

to convert from the Voltage/Amp output from the sensor to the full scale Amperage on the circuit. 

  

 3.  Sensors and Front End Components for Measuring Voltage and Current 

 Current Transformers (CTs) 

Current transformers (CTs) are sensors used to linearly step down the current passing through the 

sensor to a lower level compatible with measurement instrumentation.  The core of a current 

transformer is toroidal, or ringed, in shape with an opening in the center.  Wire is wrapped around 

the core to form the secondary and covered by a shroud or plastic casing.  The number of wire 

windings around the core dictates the step down ratio, or CT ratio, between the current in the 
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measured line (primary), and the current output connected to the instrumentation (secondary).  The 

load wire to be measured is passed through the opening in the center of the current 

transformer.  Example: A CT with a ratio of 500:5 means that a 500 ARMS load on the main line 

will result in an output of 5 ARMS on the CT secondary.  The instrument will measure 5 ARMS at 

the terminals and can apply a scaling factor input by the user to display the full 500 ARMS.  CTs 

are specified with a nominal value but often the accuracy is listed to over 100% of nominal.  CTs 

can be split core or solid core.  Split core CTs hinge open or have a removable section to let the 

installer connect the CT around a load wire without physically disconnecting the load wire to be 

measured. 

Safety Alert:  Though the CT can physically connect around an installed line, the power should be 

safely disconnected before installation of a CT.  Open secondary connections with power on the 

primary can lead to extremely hazardous Voltage potentials. 

CT options when purchasing include nominal range, opening diameter, split/solid core, output type 

(voltage/current), and output range (0.333VRMS, ±10V, 1ARMS, 5ARMS, etc.).  CT vendors can 

often customize a sensor for specific needs such as input or output range. 

  

 

Figure - 12.5 Split core CTs typically have a hinge or removable section for installation around a 

line without physical disassembly, though the power should still be disconnected. (Image courtesy 

of Magnelab) 

 

Figure – 12.6 Solid core CTs are lower cost but can require more labor to install on circuits that 

are already operational. (Image courtesy of Magnelab) 

 

CT Measurement Bandwidth 

Bandwidth of 1kHz to 2kHz is sufficient for most AC circuit power quality applications. For higher 

frequency applications connect directly to the NI 9246 or NI 9247 for up to 24kHz bandwidth or select 
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higher frequency CTs that are more expensive.  All of the modules listed in the table above have a 

bandwidth of approximately 24 kHz for signals directly connected.  High frequency CTs are more 

specialized and have bandwidth specifications in the hundreds of MHz range.  The NI 9215, NI 9222, 

and NI 9223 measurement modules sample rates range from 100kS/s/ch to 1MS/s/ch at 16-bits of 

resolution for higher frequency measurements. 

For high frequency measurements beyond the capabilities of the NI 9223, NI recommends a scope or 

digitizer for PXI designed for lab, research, and test systems.  

  

Measuring DC Current 

CTs do not measure DC current or the DC offset component of an AC signal.  For most AC power 

applications this is not necessary. When DC measurement is needed, the NI 9227 has built-in calibrated 

shunts and can measure DC current up to 5 Amps.  To measure more than 5 Amps DC, a high power 

current measurement shunt (see below) or Hall Effect sensor (see below) connected to the appropriate 

measurement module is used. 

   

Rogowski Coils 

Rogowski coils, sometimes referred to as “rope CTs”, are another sensor option for measuring current in 

a line.  Rogowski coils are similar in that they wrap around the load wire but they are flexible, have a 

much larger opening than standard CTs, and the principle of measurement is different.  Rogowski coils 

induce a voltage that is proportional to the rate of change of Current and thus require in integrator circuit 

to convert to proportional current.  The integrator is a separate box/component that is usually panel or 

DIN rail mounted, requires a DC power supply, and outputs low voltage or current signals to the 

instrumentation.  The size and flexibility of Rogowski coils make them well suited for looping around 

larger bus bars found in commercial buildings or factories, especially when they are already built and 

power measurement is added as a retrofit, but they are more expensive than a CT of comparable input 

range. 

 

 

Figure – 12.7 Rogowski coils require external power, integration circuitry (located in the black 

mountable box in the image above), and are more expensive than typical solid/split core CTs, but 

offer fast phase response and are good for retrofit installations and large bus bar measurements 

due to their large flexible opening. (Image courtesy of Magnelab) 

http://www.ni.com/digitizers/
http://www.ni.com/digitizers/
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Hall Effect Sensors 

Hall Effect sensors are based on the “Hall Effect”, named after Edwin Hall, where current flow through 

a semiconductor placed perpendicular to a magnetic field will generate a voltage potential across the 

semiconductor material.  See Lesson 6 – Magnetic Field Sensors for an academic lab focused on Hall 

Effect sensors used as a tachometer.  For the purposes of current measurement, Hall Effect circuitry is 

placed perpendicular in the core the magnetic field and output a voltage that is scaled to the current load 

in the measured line.  Hall Effect CTs typically have a better frequency response and can measure DC 

offset, but are more expensive, require power, and can be subject to temperature drift. 

  

Figure – 12.8 Hall Effect sensors have a sensing circuit perpendicular to the magnetic field and 

requires power.  Hall Effect sensors are not subject to saturation limits like a CT and can measure 

DC currents, but are more costly. 

  

Current Shunt Resistors 

Current measurement shunts, or current shunt resistors, are resistors placed in the circuit for the purpose 

of measuring the current that flows across the shunt.  These are fairly common electrical components 

and exist for a variety of applications.  Sizing a shunt will be based on measurement current range, 

output range, and power flowing through the circuit.  More expensive precision resistors are available 

for more accuracy.  Shunts do not wrap around the circuit wire and are placed in-line as a 

component.  This eliminates an isolation barrier between the measured circuit and the measurement 

equipment and can make the install more difficult than a CT or Rogowski Coil.  Shunts however, can 

measure DC currents, have better frequency response and a better phase response.  The NI 9238 module 

for Compact RIO and Compact DAQ was designed with a low range analog front end (±0.5V) 

specifically for current shunt resistors.  Additionally, the NI 9238 features 250V of channel-to-channel 

isolation. 

 

4.  Current Sensor and Transformer Vendors 

The following 3rd party companies have current and voltage measurement transformers, Hall Effect 

Sensors, and/or Rogowski Coils in their catalog.  Current shunt resistors are often sold by electronic 

component distributors such as Digi-Key Electronics. 

Magnelab offers a variety of voltage and current measurement products including current 

transformers (CTs), potential transformers (PTs), Rogowski coils, high frequency CTs, and more in 

a variety of output signal levels. 

  

Verivolt has a variety of sensors, connectors, and isolation products designed for power 

measurement applications.  

http://www.ni.com/example/13554/en/
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Additionally, several sensors have high bandwidth capability and BNC connectivity 

options for quick connection to BNC measurement modules such as the NI 9223, NI 9222, and NI 

9215 

 

 

  

 

  

Figure – 12.9 Verivolt has a variety of sensors with BNC connectivity that can connect directly to 

any NI module with BNC connectors.  Analog input modules with BNC connectivity include the 

NI 9229, NI 9239, NI 9215, NI 9222, and NI 9223. (Images left / center curtesy of Verivolt) 

  

 5. NI Hardware for Measuring Voltage 

In the scope of this paper, voltage measurements refer to AC power systems at industrial and utility 

voltage levels that range from 120VRMS for regional residential service to over 750kV for extra 

high voltage (EHV) systems on a transmission system for an electrical grid.  Instrumentation 

designed for high voltage utility applications incorporate requirements such as safety, larger gage 

wire terminals, higher thermal dissipation, and specific certification tests.  Most instrumentation 

designed for AC power measurement has an input range of several hundred Volts.  Higher voltages, 

above 1,000 VAC, typically require an external potential transformer (PT) to step the Voltage to be 

measured down to a range that is compatible with most instrumentation. 

Similar to the current measurement modules, all modules listed in table 2 use simultaneous sampled 

inputs with a 50kS/s 24-bit ADC per channel.  Compact DAQ and Compact RIO chassis will 

synchronize the voltage measurement modules in the table below with the current measurement 

modules listed in table 1, which is needed for more accurate phase and power measurements. 

 Model 

Number 
Measurement Range Measurement Technology Used 

NI 9242 250 VRMS L-N 
Direct measurement for 120/240 AC 

systems.  Connection to external PTs with a 120/240 

VRMS secondary for high voltage measurement. 

NI 9244 400 VRMS L-N Direct measurement for up to 690 VRMS L-L systems. 

NI 9225 300 VRMS AI+ to AI- Direct measurement for up to 300 VRMS systems 

NI 9238 ±0.5 V Connection to 0.333 V sensors 

http://sine.ni.com/nips/cds/view/p/lang/en/nid/212305
http://sine.ni.com/nips/cds/view/p/lang/en/nid/212307
http://sine.ni.com/nips/cds/view/p/lang/en/nid/208795
http://sine.ni.com/nips/cds/view/p/lang/en/nid/212512
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NI 9239 ±10 V Connection to 10 V sensors 

NI 9229 ±60 V Connection to 60 V sensors 

  

Table - 12.2 NI has a variety of C Series modules for all forms of Voltage measurement.  All 

modules output full waveform data for processing with LabVIEW or other measurement and 

analysis software. 

 

Figure - 12.10 The NI 9242/44 have large input terminals and high over-voltage protection for use 

in AC power and utility applications. (shown with included protective shell installed) 

  

6.  Power Calculations from Voltage and Current Waveforms 

High speed measurement equipment, as described in this paper, provides waveform data similar to 

the image below.  In this data capture from LabVIEW, the green waveform is the Voltage waveform 

from a 120 VRMS office outlet, and the red waveform is the corresponding current measurement 

for an older compact fluorescent lightbulb.  The voltage measurement module and current 

measurement module are synchronized through shared signals in the CompactDAQ or CompactRIO 

chassis.  This is important for some applications as phase shift between the voltage and current 

waveforms is one parameter of power quality that is monitored and without simultaneous sampling 

it is difficult to determine whether that shift is from the instrumentation or the circuit. 
 

 

 

Fig - 12.11 Design a LabVIEW front panel to display waveform data and power calculation 

results. 

http://sine.ni.com/nips/cds/view/p/lang/en/nid/208797
http://sine.ni.com/nips/cds/view/p/lang/en/nid/208796
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At this point in the measurement system, waveform data from the modules is used to calculate any 

power quality parameter desired.  Some of these calculations are fairly simple while others are complex 

calculations aggregated over several cycles, seconds, or minutes to determine the ultimate quality. 

 

LabVIEW has several function palettes designed for waveform and signal processing and offers 

additional toolkits for power waveform processing and calculations.  The NI LabVIEW Electrical Power 

Suite provides analysis functions for all of the fundamental power calculations discussed in this paper 

and is available for download online. The following analysis functions are included with the Full 

version of the NI LabVIEW Electrical Power Suite and conform to the IEC 61000-4-30:2008 standard: 
 

 Power frequency 

 Magnitude of the supply voltage 

 Flicker 

 Supply voltage dips and swells 

 Voltage interruptions 

 Supply voltage unbalance 

 Voltage harmonics 

 Mains signaling voltage on the supply voltage 

 Rapid voltage changes (RVC) 

 Measurement of underdeviation and overdeviation parameters 

 

  The following analysis functions conform to the EN 50160:2007 standard: 
 

 Power measurement 

 Energy measurement 

 Aggregation (demand) 

12.6 RESULT: 

 

 

 

 

12.7 PRE LAB VIVA QUESTIONS: 

1. In two wattmeter method if one wattmeter shows Negative reading then what is reason? 

2. What is the reason for low voltage in houses? 

3. What is meant by current and voltage? What is difference between the two? 

12.8 POST LAB VIVA QUESTIONS: 

1. What do you mean by the 3phase wattmeter? 

2. Explain the short how the wattmeter is connected in the circuit to measure 

3. The power delivered to the load? 
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EXPERIMENT – 13 

WORKING OF STATIC ENERGY METER USING DIGITAL SIMULATION 

 

 13.1 AIM: 

 

             Measurement of energy using a static energy meter and verification using LabVIEW. 

 

13.2 APPARATUS: 

S. No Name of  Equipment Specifications 

1 Static energy meter Trainer Kit 

 

13.2 CIRCUIT DIAGRAM: 

 
 

  

 

  

 

 

Fig – 13.1 Black Diagram 

13.3 PROCEDURE 

The conventional mechanical energy meter is based on the phenomenon of “Magnetic Induction”. It has 

a rotating Aluminium Wheel called Ferriwheel and many toothed wheels. Based on the flow of current, 

the Ferriwheel rotates which makes rotation of other wheels. This will be converted into corresponding 

measurements in the display section. Since many mechanical parts are involved, mechanical defects and 

breakdown are common. More over chances of manipulation and current theft will be higher. Electronic 

Energy Meter is based on Digital Micro Technology (DMT) and uses no moving parts. So the EEM is 

known as “Static Energy Meter” In EEM the accurate functioning is controlled by a specially designed 

IC called ASIC (Application Specified Integrated Circuit). ASIC is constructed only for specific 

applications using Embedded System Technology. Similar ASIC are now used in Washing Machines, 

Air Conditioners, Automobiles, Digital Camera etc. In addition to ASIC, analogue circuits, Voltage 

http://sine.ni.com/cms/images/casestudies/energyg.jpg?size
http://sine.ni.com/cms/images/casestudies/energyg.jpg?size
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transformer, Current transformer etc are also present in EEM to “Sample” current and voltage. The 

‘Input Data’ (Voltage) is compared with a programmed “Reference Data’ (Voltage) and finally a 

‘Voltage Rate’ will be given to the output. This output is then converted into ‘Digital Data’ by the AD 

Converters (Analogue- Digital converter) present in the ASIC. The Digital Data is then converted into 

an “Average Value”. Average Value / Mean Value is the measuring unit of power. The output of ASIC 

is available as “Pulses” indicated by the LED (Light Emitting Diode) placed on the front panel of EEM. 

These pulses are equal to Average Kilo Watt Hour (kWh / unit). Different ASIC with various kWh are 

used in different makes of EEMs. But usually 800 to 3600 pulses / kWh generating ASIC s are used in 

EEMs. Most of the EEMs installed by KSEB have out pulses of 3200 / kWh. The output of ASIC is 

sufficient to drive a Stepper Motor to give display through the rotation of digits embossed wheels. The 

output pulses are indicated through LED. The ASIC are manufactured by Analogue Device Company. 

ADE 7757 IC is generally used in many countries to make EEMs. ADE 7555 / 7755 ASIC maintains the 

international standard CLASS I IEC 687/ 1036. 

13.4 RESULT: 

 

 

 

 

13.5 PRE LAB VIVA QUESTIONS: 

1. What is the function of Static Energy Meter 

2. What is the difference between Digital Energy meter & Static energy meter?  

13.6 POST LAB VIVA QUESTIONS: 

1. Why the KWH difference between both meters 

2. What is the difference of static energy meter from ordinary energy meter? 
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EXPERIMENT – 14 

MEASUREMENT OF PASSIVE PARAMETERS USING AC AND DC BRIDGES USING 

DIGITAL SIMULATION 

 

14.1 AIM: 

Resistance measurement using Kelvin’s double bridge; Inductance measurement using Anderson                

bridge and capacitance measurement using Schering bridge and verification using LabVIEW. 

 

14.2 CIRCUIT DIAGRAM: 
 

Capacitance/Inductance Measurements with PXI DMMs 

Publish Date: Feb 03, 2017 | 39 Ratings | 3.92 out of 5 | Print | 2 Customer Reviews | Submit your 

review 

 NI Capacitance and Inductance Measurement Method 

The PXIe-4082 uses a 2-wire, multitone, constant current technique to measure impedance. When you 

apply a multitone constant current source (Isrc) to the device under test (DUT), the NI 4082 measures the 

fundamental and third harmonic of the voltage waveform. 

 

 

 

Fig - 14.1 Measuring the Fundamental and Third Harmonic of a Voltage Waveform 

  

When the current and voltage are known, the NI 4082 calculates the capacitance or inductance using 

fast Fourier transform (FFT) peak analysis. If the residual series impedance (Zs) and the stray parallel 

admittance (Yp) introduce a significant error in the measurement, the PXIe-4082 can measure the 

magnitude of the error and reduce it using compensation techniques. 

  

14.3 PROCEDURE: 

Choosing the Capacitance and Inductance Model 

Capacitive and inductive loads oppose the flow of alternating currents. This opposition is expressed as 

impedance at a given frequency. The effect of a real-world impedance load is observed as an attenuation 

of the signal and a phase shift. Because of the nature of the impedance, it is denoted as a vector whose 

angle is the same as the phase angle between voltage and current, and the magnitude of the impedance is 

the same as the quotient between the voltage and current magnitudes, as follows. 

 
Note: Bold values denote vector quantities or complex numbers. 

Z = V/I 
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http://zone.ni.com/apps/utf8/nidz_display_comments.create_comment?p_title=Capacitance%2FInductance+Measurements+with+PXI+DMMs&p_doc_id=DZTUT-3078-EN&p_doc_type=DZTUT&p_url=http://www.ni.com/tutorial/3078/en&p_doc_url_id=3078
http://zone.ni.com/apps/utf8/nidz_display_comments.create_comment?p_title=Capacitance%2FInductance+Measurements+with+PXI+DMMs&p_doc_id=DZTUT-3078-EN&p_doc_type=DZTUT&p_url=http://www.ni.com/tutorial/3078/en&p_doc_url_id=3078
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Numerically, the impedance vector is represented as a complex number either in polar form (magnitude 

and phase) or rectangular form (real and imaginary). The following equation expresses impedance in 

rectangular form: 

Z = R + jX 

where R and X are resistance and reactance, respectively. When X = 0, the load is purely resistive; 

when R = 0, the load is purely reactive. For capacitors, the reactance can be expressed as follows: 

Xc = –1/(2πfCs) 

For inductors, the reactance can be expressed as follows: 

XL = 2πfLs 

In real-world applications, loads are neither purely reactive nor purely resistive. However, they can be 

easily modeled either as a series or parallel combination of a resistive and a reactive load using the 

formulas above. 

  

 
 

 

Fig - 14. 2 You can easily model loads either as a series or parallel combination of a resistive and a 

reactive load using the formulas above. 

  

To simplify mathematical manipulation, calculation, and analysis, it is sometimes convenient to express 

the impedance as its reciprocal quantity, or admittance. Admittance is defined as 

Y = 1/Z = I/V 

and can be written as 

Y = G + jB 

where G and B are the rectangular (real and imaginary) components, known as conductance and 

susceptance, respectively. The conductance G is the reciprocal of the parallel resistance, as follows: 
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G = 1/RP 

The susceptance for capacitors is expressed as follows: 

BC = 2fCP = 1/XC 

The susceptance for inductors is expressed as follows: 

BL = 1/2fLP = 1/XL 

In general, it is mathematically easier to manipulate parallel loads as admittances and series loads as 

impedances. 

 

 
 

 

Fig - 14. 3 It is mathematically easier to manipulate parallel loads as admittances and series loads 

as impedances.  

At times, you may need to obtain the result as a series model or as a parallel model. The parallel 

resistance is typically larger than the series resistance. To measure small reactive values, such as high-

valued capacitors and low-valued inductors, it is preferable to use the series model because the series 

resistance is more significant than the parallel resistance. When measuring large reactive values, such as 

high-valued inductors or low-valued capacitors, it is preferable to use the parallel model. 
 

Type of 

Measurement 
Range Impedance Model 

C >100 uF <10 Ω Series 

C 10 nF to 100 uF 10 Ω to 10 kΩ Series or parallel 

C <10 nF >10 kΩ Parallel 

L <1 mH <10 Ω Series 

L 1 mH to 1 H 10 Ω to 1 kΩ Series or parallel 

L >1 H ≥1 kΩ Parallel 
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Note: Impedance values are calculated at the test frequency used on an NI 4072 at each specified range  

3.  Capacitance and Inductance Measurement Considerations 

  Capacitors 

A capacitor is an electronic component that is capable of storing energy as charge. Each capacitor 

consists of two plates of conductive material that are separated by a dielectric, which could be air, 

paper, plastic, oxide, or any other type of insulator. The dielectric constant, or K, of an insulator 

represents its ability to store charge. Table 2 shows the K values for different dielectric materials. 

  

Dielectric Dielectric Constant (K) 

Vacuum 1 

Air 1.0001 

Teflon 2.0 

Polypropylene 2.1 

Polystyrene 2.5 

Polycarbonate 2.9 

Polyester 3.2 

FR-4 3.8–5.0 

Glass 4.0–8.5 

Mica 6.5–8.7 

Ceramics 6 to several thousand 

Aluminum oxide 7 

Tantalum oxide 11 

 

Table - 14. 2 K Values for Different Dielectric Materials  

  

The electrical properties of insulators show variability with factors such as temperature, frequency, 

voltage, and humidity. This variability and the mechanical construction of the capacitor create a less 

than ideal device. A better representation of real-world capacitors is shown in the equivalent model in 

Figure 4, which can help you understand the different parasitic elements that are present in a real-world 

component. These parasitic elements impact the capacitor impedance at different test frequencies. 
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Figure 14.1 A Model of Different Parasitic Elements in a Real-World Component That Can 

Impact the Capacitor 

  

The parallel resistance, Rp, is usually a large value, and its effect is significant only when measuring 

capacitors with small values. The equivalent series resistance, Rs, although a small value, is important 

in capacitors with large values, where the impedance is small compared to Rs and where high power is 

dissipated. The series inductance, Ls, represents the total inductance and capacitance roll-off at higher 

frequencies. At low frequencies, capacitance varies with frequency and the test signal level, due to 

changes in the dielectric properties. The Figure 5 graph shows a 2.2 µF, 100 Valuminum electrolytic 

capacitor measured at different frequencies. The error is referenced to the measurement using a 1 

Vrms AC test signal at 1 kHz. 

 

 

Figure 14.2 A 2.2 µF, 100 V Aluminum Electrolytic Capacitor Measured at Different Frequencies 

  

These factors cause capacitors to have different values under varying conditions of temperature, 
frequency, and signal level. 

  

INDUCTORS: 

An inductor is an electronic component that is capable of storing energy as current. Each inductor 

consists of a conductive coil that can be wrapped without a core or around a magnetic material. The 

permeability of the core material is a measure of the intensity of the magnetic field that can be induced 

in it. The electrical properties of the cores show variability with factors such as temperature, frequency, 

current, and so on. This variability and the mechanical construction of the inductor create a less than 

ideal device. A better representation of real-world inductors is shown in the equivalent model in Figure 

6, which can help you understand the different parasitic elements that are present in a real-world 

component. These parasitic elements impact the inductor impedance at different test frequencies. 
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Figure - 14.3 A Model of Different Parasitic Elements in a Real-World Component That Can 

Impact the Inductor 

  

The series resistance, Rs, represents the resistive losses in the conductor. The parallel capacitance, Cp, is 

the equivalent capacitive effect between the turns of the coil, and the parallel resistance, Rp, is the sum 

of all losses attributable to the core material. Air cores require many more turns in the coil to achieve 

high-inductance values. Thus, air cores are often impractical for applications, due to their large size and 

weight. Also, air cores usually have a large winding capacitance and a series resistance with a high-

inductance value. Not all parasitics affect the value of the inductor, but some parasitics are more 

prominent than others, depending on the construction of the coil, the geometry of the inductor, the 

gauge of the wire, and the characteristics of the core. The value of the inductor and the magnitude of 

each type of parasitic in relation to the other types of parasitics determine the frequency response. The 

geometry of some components can increase the sensitivity of the components to external factors, and 

this increased sensitivity can affect the value of the inductor. Open flux inductors are more sensitive to 

metallic materials that are in close proximity because such materials modify the magnetic field. Toroidal 

inductors keep the flux inside the core and are less sensitive to external conductors in close proximity. 

Refer to Figure 7 to view the flux associated with these types of inductors: 

 

 

Figure14.4 Types of Inductor Flux 

  

In Figure 8, a 5 mH air-core inductor is measured over different frequencies. The error is referenced to 

the measurement with a test signal of 1 Vrms at 1 kHz. This type of inductor has a high degree of 

winding capacitance due to the size and number of turns required for its construction. Therefore, this 

type of inductor measures as if there were a strong variation of inductance with frequency. 
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Fig - 14. 5 A 5 mH Air-Core Inductor Measured over Different Frequencies 

   

Some ferrite cores are expected to vary greatly with the test signal level. In Figure 9, a 100 uH ferrite-

core inductor is tested at different test signal levels. The error is referenced to the measurement with a 

test signal of 1 mArms at 1 kHz. 

 

 

Fig - 14. 6 A 100 uH Ferrite-Core Inductor Tested at Different Test Signal Levels 

  

All of these factors can combine and cause inductors to have different values under varying conditions 

of temperature, frequency, and signal level. 
 

  MEASUREMENT OF RESISTANCE: 

 

 

Fig – 14.7 Resistance Circuit 
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We know that the Vin will be 5 volts from the arduino.We also know that R2 is 1k ohms. We can 

measure Vout with one of the Arduino's analog inputs like for example pin A0. With all this 3 values we 

can now calculate the unknown value of the resistor R1. So like this we've made ourselves a resistance 

meter. But the problem is the precision. With R2=1k ohms we are able to measure resistance from 0 to 

1k ohms with quite good precision. But to measure a higher resistence we have to change the value of 

R2. We will use R2=2k to measure resistors with values between 0 and 2k, R2=20k for values between 

2K and 20k and R2=200k for vaues between 20k and 200k and finally R2=1M to measure valeus 

between 200k and 1M ohms. To change the scale for R2 we could use a rotary switch where each of the 

4 pins represents a different value of resistance as we can see in the schematic below. 

 

Fig – 14.8 Simulation Circuit 
 

Ok so we want to measure the resistance of the unknown resistor. So we connect digital pin D2 to it and 

when coding we switch it to OUTPUT HIGH or INPUT in order to apply 5V or high impedance when 

needed. Using a roraty switch we could change scale. Remember to put some pulldowns to the rotary 

switch pins. We connect 5V to the middle pin of the rotary switch and 4 of the pins to digital pins D9, 

D10, D11 and D12. When D9 is high we will be in 0 to 2k ohm scale. So we set D2 to high to have 5 

volts at the unknown resistor and set D5 as OUTPUT and LOW state. We have to set D3, D4, D6 as 

INPUTS in order to make the pins have high impedance so no current will flow thrw those other 3 

resistors. When we change the scale all we need to do is change one of the others pins as OUTPUT with 

LOW state and set the others as INPUTS. Copy the code below and upload it to your Arduino. I've used 

Arduino UNO but you could use any type of Arduino. First, in order to use the LCD screen with i2c 

comunication, you have to install the i2c Lyquid Crystal library to your Arduino IDE. 

 

 Fig – 14.9 Digital Display 
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Fig – 14.10 Hardware Circuit 

 

MEASUREMENT OF CAPACITANCE: 

You can buy meters, like this one for instance: 

 
Fig – 14.11 Capacitance Measuring Device 

 

that measure capacitance, but where’s the fun in that?! 

If you’ve got an Arduino, why not build one instead? 

Update: Thank you for all the interest in this article! I have managed to increase the range, so it can 

measure capacitances of less than 1pF to over 1000uF, still with no external components! I’ve 

called this the Capacitance Meter Mk II. 

 

There are lots of examples of how to do this on the internet, but I’m going to suggest an incredibly 

simple way to it. Let’s start with the theory. 

 

http://wordpress.codewrite.co.uk/pic/2014/01/25/capacitance-meter-mk-ii/
http://www.peakelec.co.uk/acatalog/jz_lcr40.html
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Consider the following circuit: 

 
 

Fig – 14.12 Simulation Circuit 

 

CT is the capacitor under test. We start with both capacitors discharged and A2 at 0 volts. When we 

raise A2 to 5 volts a current will flow through both capacitors. The voltage on A0 will settle to 

within 1% of it’s final value within 30ns. The value that A0 will settle to is proportional to the ratio 

of CT divided by the total capacitance, C1 + CT. The formulas that we are going to need are: 

 
 

We will use the ADC to measure VA0. VA2 is actually 5 volts, so VA0 will vary from 0 to 5 volts, 

but we can use the ADC value instead, to make the calculations easier. Obviously we should then 

use the maximum ADC value (1023) for VA2. The ADC readings we can expect will range from 

about 33 for CT = 1pF to about 993 for CT = 1nF (1000pF). 

http://wordpress.codewrite.co.uk/pic/wp-content/uploads/sites/2/2014/01/SimpleCapacitanceTester.png
http://wordpress.codewrite.co.uk/pic/wp-content/uploads/sites/2/2014/01/CapTestFormulas3.png
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So now we are ready to build the circuit and write the code. Right? Well, not quite. In the circuit 

above we have specified C1 as 30pF. But the Arduino will have some stray capacitance on the 

board and in the micro-controller. About 30pF of stray capacitance. We’re going to use this to make 

our circuit simpler – we are going to remove C1. But we need to work out how much stray 

capacitance there is, so we can plug it into the formulas above. But first, we’ll build the circuit and 

write the code. 

The circuit is surprisingly easy. In fact there isn’t a circuit now. We’re going to use the Arduino as 
follows: 

 
 

Fig – 14.13 Hardware Circuit 
 

The capacitor is the capacitor under test between A0 and A2. The capacitors on the right are the 

capacitors that I am going to test a bit later on. 

The code looks like this: 

 const int OUT_PIN = A2; 

 const int IN_PIN = A0; 

 //Capacitance between IN_PIN and Ground 

 //Stray capacitance is always present. Extra capacitance can be added to 

 //allow higher capacitance to be measured. 

 const float IN_STRAY_CAP_TO_GND = 24.48; //initially this was 30.00 

 const float IN_EXTRA_CAP_TO_GND = 0.0; 

http://wordpress.codewrite.co.uk/pic/wp-content/uploads/sites/2/2014/01/CapTestBoard1.jpg
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 const float IN_CAP_TO_GND  = IN_STRAY_CAP_TO_GND + IN_EXTRA_CAP_TO_GND; 

 const int MAX_ADC_VALUE = 1023; 

 void setup() 

 { 

 pinMode(OUT_PIN, OUTPUT); 

 //digitalWrite(OUT_PIN, LOW);  //This is the default state for outputs 

 pinMode(IN_PIN, OUTPUT); 

   //digitalWrite(IN_PIN, LOW); 

 Serial.begin(115200); 

 } 

 void loop() 

 { 

  //Capacitor under test between OUT_PIN and IN_PIN 

  //Rising high edge on OUT_PIN 

  pinMode(IN_PIN, INPUT); 

  digitalWrite(OUT_PIN, HIGH); 

  int val = analogRead(IN_PIN); 

  //Clear everything for next measurement 

  digitalWrite(OUT_PIN, LOW); 

   pinMode(IN_PIN, OUTPUT); 

   //Calculate and print result 
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   float capacitance = (float)val * IN_CAP_TO_GND / (float)(MAX_ADC_VALUE - val); 

Serial.print(F("Capacitance Value = ")); 

 Serial.print(capacitance, 3); 

   Serial.print(F(" pF (")); 

   Serial.print(val); 

  Serial.println(F(") ")); 

 while (millis() % 500 != 0) 

   ;     

 } 

The code above loops round every half second, applying a 5V pulse to the capacitor, and measuring 

the voltage the other side. It then prints out the calculated capacitance (and raw ADC value). 

If we try this out it won’t be very accurate. That is because the stray capacitance isn’t exactly 30pF. 

So we need to calibrate it. I did this with a 100pF capacitor. My multimeter reckons that it actually 

has a value of 102pF. The reading I get on my Arduino board is 125pF (raw ADC value 825). So if 

we put VA0 = 825, VA2 = 1023 and CT = 102 into the second equation, this tells us that C1 is 

24.48pF. So I changed IN_STRAY_CAP_TO_GND to 24.48 and uploaded this to the Arduino. 

This time the value displayed on the serial monitor is 102pF (most of the time!). 

 
 

Fig – 14.14 Display 

 

I tried it out with the following capacitors: 

http://wordpress.codewrite.co.uk/pic/wp-content/uploads/sites/2/2014/01/CapTestSerialMon1.png
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Fig – 14.15 Capacitors 

 

This was the results of my tests: 

Capacitor Reading 

  

– 0.072 pF (3) 

15J 15.461 pF (396) 

22J 23.403 pF (500) 

47J 48.532 pF (680) 

101J 102.000 pF (825) 

471K 448.030 pF (970) 

102K 1064.348 pF (1000) 

392K 3553.097 pF (1016) 

472K 4984.128 pF (1018) 

 

14.7  RESULT: 

 

 

 

http://wordpress.codewrite.co.uk/pic/wp-content/uploads/sites/2/2014/01/MiscCap1.jpg
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14.8 PRE LAB VIVA QUESTIONS: 

 

1. What is the function of Kelvin double bridge 

2. What are the bridges used to measure resistance 

14.9 POST LAB VIVA QUESTIONS: 

 

1. What are the bridges used to measure capacitances 

2. What are the bridges used to measure inductance 


